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1.1  Formatting Guidelines

1.1.1 Guidelines to formatting your RICR document
A. The standard font to use for rules documents is Arial size 12.

B. Use only the RICR-specific styles. After installing the RICR Template, you may
see additional styles in the drop-down list of styles, styles that Word has
automatically generated. Those additional styles do not affect the documents you
create, but remember, use only the RICR specific styles.

C. Do not use the Design ribbon in Word to apply styles to your document. Use the
Styles available in the Home ribbon.

D. To view examples of what the text looks like when the various styles are applied,
see Appendix 1 Examples of Styles in the RICR Template or Appendix 2
Example of Requlation in the RICR Style.

E. When you copy and paste text from an existing document, you can avoid
introducing additional styles by selecting “Paste Special” from the “Edit” menu,
and then select “Unformatted Text”, but this option will also remove Bold, Italics
and Underlines.

F. It is not permitted for a user to apply Bold, Italics and/or Underlines in the
document for any reason except to track changes or, in the case of Italics only,
Latin/legal terms. Some RICR Styles will apply Bold to text as part of the style
but it may not be applied manually outside of the RICR Styles. They may not be
used for emphasis. It may be necessary to click on a selected RICR style twice to
apply the changes when cutting and pasting into the template to remove any
remaining formatting such as underlines, bold, etc.

G. Each paragraph in a rule should have its own appropriate number/letter for
citation purposes (except for Definitions- see § 1.1.6 Definitions).

H. You can review your Title structure by clicking “View” at the top of the document,
then checking “Navigation Pane”.

If you want the tables in your document to be searchable, create simple tables
that can appear within the rule text.

J. Table of contents (TOC) may be included in submitted rules. The TOC should
start at the top of a new page. A page break should follow the TOC. Pages
including the TOC should not contain any other content.

K. You may not use any headers or footers in your rule. No page numbers or
footnotes should appear in your rules. Citations should be handled in the body of
the document and should be formatted in accordance with § 1.1.7 Citations.
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1.1.2

1.1.3

When submitting a rule using the Department of State Rules and Regulations
Database Submission Tool, please add the RICR citation in parenthesis following
the title of the rule in Filing Form Section 2. Title of Rule.

Example: Rules Applicable to Nonregulated Power Producers (815-RICR-40-05-
1)

Contact the Administrative Records Office staff if you need help creating
documents or with the Rules and Regulations Database Submission Tool.

Do’s and Don’ts

Final rules files must be saved as a PDF file. This file must be created from the
original word processing document so that it is searchable. Scanned PDFs are
not acceptable.

Be sure to apply RICR styles to all text.

Use track changes or strike-out and small caps to indicate amendments in
proposed rules and redline documents.

Number rules and insert bullets manually. Turn off automatic numbering and
bullets.

Tabs need to be inserted between the rule number and the text of the heading or
paragraph for proper alignment.

Use the paragraph styles to indent your paragraphs and tab to properly align the
first line.

Do not insert an additional hard return after a heading or a paragraph as the
template automatically inserts a line space when you start a new heading or
paragraph.

Working with the RICR Template and Microsoft Word
Download the RICR Template

1. Download the RICR Template (RICR Template) from
http://sos.ri.gov/divisions/open-government/state/rules-and-requlations

or

http://sos.ri.gov/dar_filing/front/ (REQUIRES LOGIN CREDENTIALS).

2. Save the template on your local drive.

3. The RICR Template contains all RICR styles necessary to format your
document correctly.
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C.

How to Display the Style Area in the Document Window

,,,,, 3%
1. You can quickly verify what Fecsming [iow 3] B
. Dispigy ™ Use dreft font in Draft 2nd Outine views
style has been applied to each | ... .

heading or paragraph by

[ Usefonts that are stored on the ganter

displaying the “style area .
” “ H H ” [ Expznd 2 headings when opening 2 documnent
pane” or “Navigation” pane to :
the left of your document. sevmemsectmotoomes 53 J
Trust ™ Quick < rumbber of Recent Documents. 8 -

5 =

2. In Office 2010 and later S s e
(except Outlook): w =

a. Click File.

b. Click Options.

C. Click Advanced.

[ tdsedrfrguality =l

d. Change the “Style area e e

width” to 1 inch and click OK at the bottom of the “Word Options”
window.

e. You can change views at any time by clicking the “Draft View” icon
in the “View” menu at the top of the screen.

Display Styles Window

1. Styles can also be applied from the “Styles” window. To display the Styles
window:
a. Click on the small arrow at the bottom right corner of the “Styles”

block of the ribbon that displays when you select the “Home” tab.

b. The “Styles” window will open to the right of your document.

ACROBAT 9 Tell me what you want to do

AaBb( AaBbCc AaBbC: Aagbcer AaBbCe AaBbccl FAG@E AaBbCcl AaBbCe AaBbCe AaBbCc)|
Heading 1 Heading2 Heading3 | TNormal | TRICRCh.. RICR Dep.. TRICRHe.. TRICRPart TRICR Su.. TRICRSu.. TRICR Text \ s

Styles IF}

Turning off Auto Numbers and Auto Bullets

You may want to turn off auto-numbers and auto-bullets as both need to be
manually keyed in Rules documents. In Office 2010 and later (except Outlook):

1. Click File.

2. Click Options.
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6.

Click Proofing.
Click AutoCorrect Options.
Select “AutoFormat As You Type”.

Deselect “Automatic bulleted lists” and “Automatic numbered lists”.

E. Pasting Rule Text into the RICR Template

1.

2.

Open your rules document.

Select all the text (Ctrl + A) and copy (Ctrl + C).

Close the document.

Navigate to the RICR Template saved on your local drive and open it.
Paste your text (Ctrl + V) into the new document.

Save As an .rtf or .doc file with a new name.

You can now begin to type new text or copy and paste text from an
existing document, and then apply the RICR Template styles.

F. Creating Rules Documents and Applying RICR Styles to the Text

1.

Proposed Rules Document

Track Changes Method: To create a “Proposed Rules” document, you
can use the Track Changes feature in Word or “strike-out” and “small
caps”.

a. Track Changes can be found on the “Review” tab ribbon. Select it
to turn it on.

b. After completing the changes save your document as an .rtf or a
.doc file.

C. Now add your Notice of Proposed Rulemaking to the beginning of

this document and save your proposed rules packet as a .pdf for
upload to the Rules and Regulations Database Submission Tool.

Manual Method: Some agencies prefer not to use Track Changes and to
manually create a redline (proposed rules) document. To manually
strikeout text:

a. Select the text and then click on the bottom right corner of the
“Font” block of the “Home” tab ribbon.
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b. When the window opens, click the “Strikethrough” check-box and
close the window.

C. Before typing new text to be inserted, open the “Font” window, click
the check-box next to “Small Caps” and close the window.

d. It may seem laborious to use small caps instead of using caps lock,
but if you use this method, both the stricken text and caps can be
removed in minutes when you are ready to create your final rules
document. To make this process simpler, keyboard shortcuts or
toolbar buttons can be set up.

2. Final Rules Documents
Track Changes Method:

a. Accept the changes and review the document to make sure all the
changes appear correctly.

b. Save your document as a PDF file. The proposed rules document
may be used as the redline document, but may need to be modified
after the hearing.

Manual Method:

a. Use the “Replace” feature found on the “Home” tab ribbon to
remove stricken language.

b. After opening the Replace window, place your cursor in the “Find
what” field, select the “More” button and then select “Format” and
“Font”.

C. When the “Font” window opens, select “Strikethrough” and click
“‘OK”.

d. Complete the process by selecting “Replace All” and close the
window.

e. All stricken text should now be removed.

f. To change the “Small caps” to normal font, select all text (Ctrl + A),

select “Font” under the “Edit” drop-down and deselect “Small caps”
and close the window.

g. All the text should now be changed to normal font.
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Review and proof your document for accuracy and save the file as
an .rtf or a .doc file for your records and a PDF for upload to the
Rules and Regulations Database Submission Tool.

G. Applying Styles to Text

Styles can be applied by displaying the Styles Window to the right of your document.

To apply styles, use one of the following two methods:

1.

2.

Select a style and insert new text.

a.

b.

Choose the style you would like to use.

Type your text or insert Unformatted Text or Formatted Text (RTF)
from another document using “Paste Special’.

The style chosen applies to all text inserted from that point and
forward.

REMEMBER: Pasting as “Unformatted Text” will remove all Bold,
Italics and Underlines.

Apply a style to existing text.

a.

Click anywhere in a paragraph or heading, or highlight (select) the
text to be styled.

Click on the style you would like to apply.

The style chosen applies to all text in the paragraph or heading up
to the point of the first hard return, or all highlighted or selected text,
which allows you to select more than one paragraph.

REMEMBER: No matter what “Title” level (heading level) the text of
the rule falls under, whether the text is under a Title 1 or a Title 4,
always start the text of the rule using the ‘RICR Paragraph 1’ style.

H. Numbered or Bulleted Paragraphs

For numbered paragraphs:

1.

Select the ‘par’ style you would like to use, depending on the level of the
paragraph.

You will need to manually number paragraphs. Type the paragraph
number, then insert a tab.

Type or insert the text of the paragraph.
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1.14

1.15

For bulleted paragraphs:

1. Select the ‘par’ style you would like to use, depending on the level of the
paragraph.
2. Insert a bullet and then type or paste in the text of the bulleted paragraph.

REMEMBER: Do not use Auto-Numbering or Auto-Bullets created in
Word. All numbers or bullets must be inserted manually.

Style a Table in Word

Create tables using Word’s Table feature found on the “Insert” tab. If possible,
avoid using partial borders. You can apply bold and italics. You can also use
merged cells and shading in your tables.

Graphics

When filing documents with the Department of State you may leave maps and
figures embedded in your rules documents.

Graphics and large tables can be presented in landscape view, for better
appearance and usability.

Figures, graphics, and tables should be treated as paragraphs and
subparagraphs using the appropriate RICR styles. The title of the figure, graphic,
or table should be styled at the appropriate level. The actual figure, graphic, or
table should be styled as if it were text below the paragraph-level style.

Example:
1. Structural Shoreline Protection Standards for Coastal Greenways
i
0 [T}
i
[Gfii
(1]

e

Figure 3: Hypothetical site plan showing a vegetated revetment on a site
with parking on the ground level of the new structure. Drawing by Thomas
VanHollebek, URI Coastal Resources Center/Rhode Island Sea Grant.
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1.1.6 Definitions

A. Use the following guidelines for formatting definitions:

1. Place definitions towards the beginning of the regulation.

2. Arrange the words or specific terms in alphabetical order.

3. Uppercase the first letter of the first word in each definition. All subsequent
words in each definition should be lowercase, unless words are proper
nouns.

4, Place the word or term being defined within quotation marks.

5. Immediately after the word or term being defined, insert the word “means.”

6. Avoid using dashes, slashes or parentheses in a term being defined. For

example, use “Individualized education plan” or “IEP” means... instead of
“Individualized education plan (IEP)” means....

7. Definitions are not required to have individual paragraph numbers or
letters.

1.1.7 Citations

The purpose of this section is to provide a uniform system of citation to agencies when
revising/reformatting their regulations through the APA Revision process. Materials not
addressed in this section should not be cited or referenced within regulations.

What is outlined below is a uniform citation which takes into account (1) ease for the
non-lawyer reader; (2) ease for the non-lawyer agency drafter; (3) ease for the out-of-
state reader; (4) how other states cite to materials in their regulations; and (5) the
requirements of the Rhode Island APA.

A. INCORPORATION BY REFERENCE VERSUS CITATION

1. Before you can cite to the material, you need to identify what type of
material you are citing to and whether you are incorporating it by
reference.

a. INCORPORATION BY REFERENCE
(1) Federal Regulations

The Rhode Island APA allows agencies to incorporate

federal regulations by reference. This includes materials
properly incorporated by reference in federal regulations.
Incorporation by reference is a drafting tool which allows
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agencies to give legal effect to federal regulations to allow
for state level enforcement without publishing the regulation
in full.

(2) Scientific/Technical Materials

The Rhode Island APA also allows agencies to incorporate
“published codes, standards or guidelines of any nationally
recognized scientific or technical association or organization”
which is “regularly in the business of developing scientific or
technical standards or guidelines, is recognized by those in
the relevant professional community as having a high degree
of expertise and competence in its field, and whose
publications are widely distributed and easily available
throughout the nation and the state of Rhode Island.”

This is a drafting tool which allows an agency to give a code,
standard or guideline of such an organization full legal effect
(full force of law) so that the agency can then enforce
compliance with that code, standard or guideline.

Note: You cannot cite or incorporate guidance documents, agency policy or
agency guidelines.

b. CITATIONS

(1)  State and federal statutes already have the force of law
behind them and therefore you need not “incorporate” them
formally, you can simply reference them. State of Rhode
Island regulations that have been properly promulgated are
analogous to state statues in that they already have the
force of law behind them on a statewide level. As such, they
can be referenced without formally “incorporating” them into
the regulation. This is a particularly helpful tool to avoid
conflicting regulations.
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Quick Reference Guide:

Incorporation by Reference: You can only incorporate by reference:

Federal regulations;

Materials properly incorporated in federal regulation;

or

Codes, standards or guidelines published by nationally recognized scientific or
technical organizations

Citation: You can only cite to the following sources without formally incorporating them by
reference:

e Rhode Island statute;
¢ Rhode Island regulation (which has already been properly promulgated); or
e Any federal statute.

B. HOW TO CITE MATERIALS

1. HOW TO CITE TO A FEDERAL STATUTE

a. Full Citation:
Official name of act Abbreviation of code cited
—
Comprehensive Environmental Response, Compensation, and Liability Act, 42 U.S.C. § 9601.
\
Title Section symbol  Section

with space

b. Short Citation:

42 U.S.C. § 9601.

Note: Only write the full name of the statute the first time it is cited within a Part.
After the statute has been cited once in a Part, you can use the short citation.

2. HOW TO CITE TO A RHODE ISLAND STATUTE

Section symbol
with space

R.I. Gen. Laws § 9-19-27.
Abbreviation of “Rhode  Title Chapter Section
Island General Laws”
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Note: You can find the “Section” symbol (§) in Word under “Insert”> “Symbol” >
“Special Characters”. You can create a shortcut key to quickly access the §
symbol if you will be using it frequently.

3. HOW TO CITE TO A RHODE ISLAND REGULATION
a. When citing to a different Title:

Abbreviation of “Rhode Island Code of Regulations”

216-RICR-20-15-7.

I

Title Chapter Subchapter Part

Abbreviation of “Rhode Island Code of Regulations”

216-RICR-20-15-7.2(A)(1)(a)(1).

VA ——

Title Chapter ~ Subchapter Part Section Subsections

b. Citing within the same Part

(2) Citing to a Section within a Part: § 7.2 of this Part.

(2)  Citing to a Subsection within a Part: § 7.2(A) of this Part.
C. Citing within the same Subchapter

(1) Citing to a Part within the same Subchapter: Part 7 of this
Subchapter.

(2)  Citing to a Section within the same Subchapter: § 7.2 of this
Subchapter.

(3) Citing to a Subsection within the same Subchapter: § 7.2(A)
of this Subchapter.

d. Citing within the same Chapter:

Q) Citing to a Subchapter within the same Chapter: Subchapter
15 of this Chapter.

(2) Citing to a Part within the same Chapter: Subchapter 15
Part 7 of this Chapter.
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3) Citing to a Section or Subsection within the same Chapter: 8§
15-7.2(A) of this Chapter.

e. Citing within the same Title

() Citing to a Chapter within the same Title: Chapter 20 of this
Title.

(2) Citing to a Subchapter within the same Title: Subchapter 20-
15 of this Title.

3) Citing to a Part within the same Title: Part 20-15-7 of this
Title.

(4)  Citing to a Section or Subsection within the same Title: § 20-
15-7.2(A) of this Title.

Note: If you are citing a rule that has not been given a RICR citation, use the title
of the citation (i.e. “Department of Health Rules and Regulations Regarding
Health Care Workers.”)

C. HOW TO INCORPORATE A MATERIAL BY REFERENCE
1. Step by Step Guide for Incorporation by Reference

a. Step One:  Create an “Incorporated Materials” Section. We
recommend that this come between the “Authority” and “Definition”
sections of the regulation.

b. Step Two: Create a subsection for each material you wish to
incorporate by reference.

C. Step Three: Add language “These regulations hereby adopt and
incorporate [insert citation] by reference, not including any further
editions or amendments thereof and only to the extent that the
provisions therein are not inconsistent with these regulations.”

d. Step Four: Insert citation in format described below.

Note: If the material is not considered a federal regulation, a material properly
incorporated by reference in a federal regulation or a scientific/technical material,
it cannot be incorporated by reference.
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2. EXAMPLE OF INCORPORATED BY REFERENCE SECTION WITH
CORRECT CITATIONS

3.3 Incorporated Materials

A. These regulations hereby adopt and incorporate 16 C.F.R. § 444.1 (2014)
by reference, not including any further editions or amendments thereof and
only to the extent that the provisions therein are not inconsistent with these
regulations.

B. These regulations hereby adopt and incorporate the American Medical
Association’s “Standards for Taking Blood Samples” (2001) by reference,
not including any further editions or amendments thereof and only to the
extent that the provisions therein are not inconsistent with these regulations.

C. These regulations hereby adopt and incorporate the “National Geological
Society Guidelines for the Safe Gemstone Excavation” (2015) by reference,
not including any further editions or amendments thereof and only to the
extent that the provisions herein are not inconsistent with these regulations.

Note: You can cite to the incorporated material in the body of your regulation by
referencing the Incorporated Materials subsection.

a. Examples:

(2) Phlebotomists must maintain their syringes in the manner
prescribed in “Standards for taking Blood Samples”,
incorporated above at § 3.3(B) of this Part.

(2)  Geologists must mine for diamonds in accordance with
“National Geological Society Guidelines for the Safe
Gemstone Excavation”, incorporated above at § 3.3(B) of
this Part.

D. CREATING CITATION FOR INCORPORATION OF FEDERAL REGULATIONS
BY REFERENCE

Abbreviation of set of regulations cited

r—H
7 C.F.R. § 319.76 (2012).

A

Title Section Section  Date of code
symbol edition cited
with space
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1.1.8

1. Give the name of the regulation only if the regulation is commonly cited
that way:

Name of regulation o ) X . .
Abbreviation of set of regulations cited

I —
Credit Practices Rule, 16 C.F.R. § 444.1 (2014).

T 7 <

Title Section Section  Date of code
symbol edition cited
with space

Note: When you submit your incorporated material to the Secretary of State’s
office, be sure to send the URL of your material with it.

Note: You should be incorporating the most recent version of the C.F.R. If you
have previously referenced a C.F.R. from a prior year, changing the year will be
a substantive change that should be marked by track changes.

Note: The year is required for all materials incorporated by reference.

CREATING CITATION FOR INCORPORATION OF SCIENTIFIC/TECHNICAL
MATERIALS BY REFERENCE

1. The Rhode Island APA requires that the reference include the name of the
association or organization, the title of the material and the date of the
material.

Note: When you submit your incorporated material to the Secretary of State’s
office, be sure to send the URL of your material with it.

Troubleshooting Formatting Problems

Occasionally, when you open a document, the text may appear to have lost the
styles you have applied. If that happens, try Copying and Pasting into a new
Template Document:

1. Select all the text (ctrl + A) and copy it (Ctrl + C).

2. Close the document.
3 Navigate to the RICR Template saved on your local drive and open it.
4, Paste your text (Ctrl + V) into the new document.

5. Save As an .rtf or .doc file with a new name.

Turning off style restrictions in the RICR Template
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1. Pop the Style Window out to anchor on the right side of your document by
clicking on the small box at the bottom right of the Style ribbon.

RICR Filing an

Developer  ACROBA

AaBb( AaBbCt AaBbC: AsBbcer AaBbCe Aabcel FAGE AaBbCel AaBbcc A3BbCe AaBbCel

Heading 1 Heading2 Heading3 TNormal TRICRCh.. RICRDep.. TRICRHe.. TRICRPat TRICRSu.. TRICR Su. R Text -

Styles

2. Click on Manage Styles button.

3. Click -> Restrict tab and unclick the Limit formatting to permitted styles
check box -> click OK.

‘ Edit | Recommend | Restrict | Set Defaults ‘

Sort order: | As Recommended EI Show recommended styles only

Select one or more styles to set their availability when a document is protected for formatting
changes

»

RICR Paragraph 1

RICR Paragraph 2 I
RICR Paragraph 3

RICR Paragraph 4

RICR Part

RICR Subheading/Subchapter
RICR Text
RICR Title Number
8 Table Grid e

l Select Visible I [ Select Buift-in l l Select All

Set availability of selected styles

Permit ] l Restrigt I

R - R P
Limit formatting to permitted styles  <f—
["] Allow autoFormat to override formatting
[ Block Theme or Scheme switching

|:| Black switching to a different style set

(@) Only in this document New documents based on this template

o) o

|

4, You can always turn the restriction back on following the same steps and
clicking->Limit formatting to permitted styles->OK. When you turn the
Restriction back on you will receive a pop-up box. You do not need to
enter a password. Just click ->OK.
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C.

Importing RICR Styles into any Word document

1.

Open the document you want to import style to in Word then

click File>Options>Custom Ribbon to add the Developer under the Main

Tabs to ribbon.

eneral :
! @ Customize the Ribbon and keyboard shortcuts.
Display
Choose comman. de from:
|| Froring Popular Commands [=]
Save
3} Accept and Move to Next
Typography = Align Lent
=
Language V3 Breaks
IS Bulets ’
Advanced E Center

= Change List Level

I 4 cut

Quick Access Toolbar
Define New Number Format...

Adddns &) Delete
7 DrawTable
Trust Center [ Draw Vertical Text Box
4 Email
A Find
Fant I
A Font.
A Font Color .
Fant Size Ir
F Format Painter
A" Grow Font
B, Hyperink.
AE' Insert Footnote
= Line and Faragraph Spacing

Keyboard shorkeuts: | Customize... |

Customize the Ribbon:

Main Tabs

F B
Templates and Add-ins m

Templates | XML Schema | XML Expansion Padks | Linked c35 |

Document template
Normal Attach...
[ Automatically update document styles
Attach to all new e-mail messages
Global templates and add-ins
Chedked items are currently loaded.

Full path:

[ognee. | «—— [ ] [ canwl |

w

Main Tabs
= [¥] Home

® Clipboard

¥ Font

® Paragraph

[ Styles

¥ Editing

5 [ Hew Tab |
& ] Insert

(Custom)

 [] Page Layout
& [¥] Reterences

& (] Mailings
&[] Review
B[] View

__‘:. V] Developer

® 4] Addins
# ¥ kutools

(4] Enterprise
& /| Blog Post

% /] Insert Blog Post)

& V] outlining

% (¥ Background Removal

Ney Fab

| | tewGroup | | Rename..

Customizations: |

Reset ©

| Imgort/Export ~ |1

Click Document Template under Develop Tab, there will be a popup

dialog, and click Organizer.

There will be another popup dialog, click Close File on the right.
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4. Click Open File, and select RICR-Template.dotx, then click Open.

Organizer

EEA=)

Styles | Macro Project [tems ]

In import skyle:
-

Table Normal

Styles available in:
import style (Document) El

Description
Style: Hide untd used, Priosity: 2

Styles available in:

5. After opening the RICR-Template.dotx, you can select the RICR styles in
the right box and click Copy, it will copy the style to the left box.

Organizer

?EE 9

. Styles | Macro Project Items

In export style:

import style (Document) E' export style (Document) 3
Cosge
Descripbion
Font: 10 pt
Line spadng: single, Space
After: 0 pt, Style: Linked, Hide until used, Priority: 100
R
6. After the copy, click Close, the style importing is finished.

1.1.9 RICR Classification System

The Rhode Island Code of Regulations (RICR) is a classification system that orders
regulation by agency. Each agency is then organized into chapters, sub-chapters, parts,

and sections.

The RICR has five (5) major divisions:
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Title:

Chapter:

Sub-Chapter:

Agency name.

A core function of the agency. Some smaller agencies may not
need this level, but it is required and will be labeled “00” if not

appl

icable.

Topic area within a core function of the agency. Larger agencies
may need this additional level; it is required and will be labeled “00”
if not applicable.

Part: A set of rules on a specific topic.
Section: A specific rule.
Title Code | Chapter Sub- Part Section
(Agency) (Function) Chapter
(Topic)
100 RICR |10 05 1 A(A)(D)(@)(1)
Citation 100-RICR-10-05-1.1(A)(1)(a)(1)
EXAMPLES
TITLE CODE | CHAPTER SUB- PART SECTIONS
CHAPTER
Dept. of RICR | Agriculture Animal Species- Dogs, Cats,
Environmental and Care Specific Rabbits, etc
Management Resource Facilities Standards
Marketing
ERLID: 8321
Dept. of RICR | Food Frozen Construction | Coverage,
Health Protection Food and Layout of | Location,
Products Frozen Food | Separation,
ERLID: 157 Plants Water Supply,
etc.
Dept. of RICR | Commercial | N/A Regulation Purpose,
Business Licensing 13-Unit Definitions,
Regulation Pricing Exemptions, etc
ERLID: 3851
A. Title-100

This classification level represents state agencies. These include general offices,
executive branch agencies, and quasi-public agencies. The numbering scheme
begins with 100 and increases by multiples of 2, 5 or 10 based on the entity type
and its relationship to other entities in the code. The three-digit indicator allows
for growth over time, including the placement of new agencies near related
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agencies in the code (e.g. EOHHS is 210, with sub-agencies represented by 212,
214, etc.).

Rhode Island Code of Regulations (RICR)

The four-letter code, RICR, immediately indicates a Rhode Island regulation, as
‘RIGL” indicates a statute.

Chapter-10

This classification level represents major agency functions. Agencies will
distinguish between functions by assigning chapter numbers using a skip 10
method (e.g. 10, 20, 30...110, etc.). The skip method allows room to insert new
functions near related functions. Agencies will use “00” if there is no chapter.

Sub-Chapter-05

Agencies can use this level to organize functions by topic area if necessary.
Agencies will assign sub-chapter numbers using a skip 5 method (e.g. 05, 10,
15). Agencies will use “00” if there is no sub-chapter.

Part-1

A Part represents a group of rules around a specific topic. Parts are represented
by a 1-point numbering scheme (i.e. each part is sequentially numbered).

Sections- .1, A,1,a,(1)

Sections may be divided into four levels:

1. subsections — (ex. .1, .2, .3, .4, etc.);
2. paragraphs — (ex. A, B, C, D, etc.);
3. subparagraphs — (ex. 1, 2, 3, 4, etc.);
4. clauses - (ex. a, b, c, d, etc.); and

5. sub-clauses — (ex. (1), (2), (3), (4), etc.).

Note: Agencies should make every attempt to limit the number of sub-section levels to
no more than five levels to reduce regulatory volume while maintaining readability.

Additional Rules Surrounding Code Design
1. Decimal points will not be allowed at the Title or Chapter level.

2. Sections or subsections cannot be renumbered to accommodate for
repealed regulations.

Nellie M Gorbea — Secretary of State Page |22



H. Comparison to the Code of Federal Regulations

The RI Code of Regulations is based on the Code of Federal Regulations’ classification

scheme.
CFR RICR

Title Topic Area Agency
Chapter Agency Function
Sub-Chapter | Topic/Function Topic under function
Part A set of rules A set of rules
Section Specific rule Specific rule

Title Example

Title Chapter Subchapter

Administration

Legal Services

Health Source RI

Office of Diversity, Equity and
Opportunity

Equal Opportunity Office

Human Resources Outreach

and Diversity Office

Minority Business Enterprise

Compliance Office

Division of Capital Asset
Management and Maintenance
(DCAMM)

Fire Safety Code Board of

Appeal and Review

Office of Planning, Design, and

Construction

Office of Risk Management

Office of State Fleet Operations

Division of Enterprise Technology
Strategy and Service (ETSS)

Office of Library Services

Office of Digital Excellence

Office of Information
Technology

Division of Human Resources

Office of Personnel
Administration

Employee Benefits

State Employees Workers’

Compensation

Office of Management and Budget

Office of Internal Audit

Budget Office

Office of Regulatory Reform

Performance Management

Planning

State Planning Counsel

Purchases

State Properties Committee

Nellie M Gorbea-S
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1.1.10 RICR Code Structure

All questions on the Title designations should be directed to the Department of State’s
Administrative Records Office.

Nl]-rlsllt?er Agency
100 Department of State
110 Attorney General
120 Treasury Department
130 Auditor General
150 Judicial
152 Unauthorized Practice of Law Committee

154 Workers' Compensation Court Medical Advisory Board

160 Permanent Joint Committee on Legislative Services

170 Executive Office of Commerce

180 The Office of Veterans Affairs

200 Department of Elementary and Secondary Education

202 Board of Education

204 Council on Secondary and Elementary Education
210 Executive Office of Health and Human Services
212 Department of Behavioral Health, Developmental Disabilities and Hospitals

214 Department of Children, Youth, and Family

216 Department of Health

218 Department of Human Services

220 Department of Administration

222 Minority Business Enterprise Commission

Department of Business Regulation (includes the Office of the Health Insurance
230 Commissioner)

240 Department of Corrections

242 Parole Board

244 Batterer’s Intervention Program Standards Oversight Committee

250 Department of Environmental Management
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260 Department of Labor and Training

270 Department of Public Safety

280 Department of Revenue

290 Department of Transportation

300 Office of Energy Resources

400 Board of Accountancy

405 Board of Certification of Operators of Wastewater Treatment Facilities
410 Board of Elections

415 Board of Examination and Registration of Architects

420 Board of Examiners of Professional Landscape Architects
425 Board of Medical Licensure and Discipline

430 Board of Registration for Professional Engineers

435 Board of Registration for Professional Land Surveyors
440 Contractors' Registration & Licensing Board

445 Energy Facility Siting Board

450 Fire Safety Code Board of Appeal and Review

455 Governor's Workforce Board (formerly known as Human Resource Investment Council)
460 Labor and Training Board of Review

465 Labor Relations Board

470 Motor Vehicle Arbitration Board

475 Personnel Appeals Board

480 State Housing Appeals Board

485 Underground Storage Tank Review Board

490 Water Resources Board

500 Advisory Commission on Historical Cemeteries

505 Agricultural Lands Preservation Commission

510 Building Code Commission

515 Commission for Human Rights

520 Ethics Commission
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525 Governor's Commission on Disabilities

530 Historical Preservation & Heritage Commission
545 Judicial Nominating Commission

550 State Traffic Commission

555 Vehicle Value Commission

600 State Properties Committee

650 Coastal Resources Management Council
655 Council on Postsecondary Education

660 Rivers Council

665 State Council on the Arts

670 State Planning Council

800 Airport Corporation

805 Capital Center Commission

810 Public Utilities Commission

815 Division of Public Utilities and Carriers

820 Health and Educational Building Corporation
825 Housing and Mortgage Finance Corporation
830 Infrastructure Bank

835 Narragansett Bay Commission

840 Public Transit Authority

845 Resource Recovery Corporation

850 Student Loan Authority

855 Turnpike and Bridge Authority

860 Housing Resources Commission

865 [-195 Commission

870 Commerce Corporation

875 Industrial Facilities Corporation

880 Quonset Development Corporation
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1.2 Filing Guidelines

This section’s purpose is to guide agencies on the mechanics of filing rules and
regulations with the Department of State using the Rules and Regulations Database
Submission Tool.

For guidance on creating state regulations, please refer to the Office of Management
and Budget Rhode Island Administrative Procedures Act Regulatory Manual and related
documents, found at www.omb.ri.gov/reform.

1.2.1 Notice of Proposed Rulemaking (8 42-35-2.7)

A.

This section will prepare you for posting notice of proposed rulemaking (R.l. Gen.
Laws § 42-35-2.7) once the required regulatory preparation and analysis has
been completed (R.I. Gen. Laws 88 42-35-2.9, 42-35.1-4, 22-12-1.1, and
Executive Order 15-07).

1. For guidance on completing advance notice of proposed rulemaking,
please contact the Office of Management and Budget.

2. For emergency filings, please skip to 1.2.4 Emergency Rules.

When you are ready to submit your rule to the Rules and Regulations Database,
first send a copy of your proposed rule in Word format to: rulesregs@sos.ri.gov.
The Administrative Records team will review the rule for compliance with the
formatting provisions of the RICR. Once the Administrative Records Office has
reviewed and approved your rule, you may proceed to upload that rule to the
Database. If the Administrative Records Office fails to respond after five
business days, you may upload your rule to the Database without Administrative
Records Office approval.

NOTE: § 42-35-4 authorizes the Secretary of State to reject the filing of a final
rule if the rule fails to comply with RICR formatting guidelines. Implementing this
additional level of review will prevent rejected filings by correcting non-
substantive errors prior to publishing a rule for public view.

Beginning with a word processing document, create a PDF through “Save as
PDF”. Do not scan a document to create a PDF as this will not be searchable or
accessible to those using assistive technologies. When saving the PDF file, do
not put any spaces or special characters (ex. *&"%$) in the file name. Also, use
short file names (for example: Procedural_Rules 2016.pdf OR
ProceduralRules2016.pdf). If you have multiple proposed rules, you must create
a separate PDF file for each rule, and upload each rule separately. The PDF files
must have different names as the database will hold only one file with any given
name.
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D. If you require assistance making a searchable and accessible PDF, please
contact the Administrative Records Office at (401) 330-4801/437-4130 or
rulesregs@sos.ri.gov.

E. The Notice of Proposed Rulemaking must contain the following in a single PDF:

1. a short explanation of the purpose of the proposed rule;

2. a citation or reference to the specific legal authority authorizing the
proposed rule;

3. the text of the proposed rule; clearly mark the proposed language by
underlining proposed insertions, and striking through proposed deletions;

4, the regulatory analysis, as well as how to obtain complete information on
the analysis;

5. where, when, and how a person may request a hearing or otherwise
comment on the proposed rule (including the dates of the public comment
period);

6. the date of the filing of the Notice of Proposed Rulemaking;

7. citations to each supporting scientific or statistical study, report, or
analysis; and

8. if the proposed rule supersedes an existing rule, a summary of all non-

technical changes made to the proposed rule. Technical changes include
corrections to grammar, punctuation, and formatting which do not modify
the substantive meaning or scope of the rule.

For an example of a Notice of Proposed Rulemaking, see Appendix 6: Public
Notice of Proposed Rulemaking.
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Prepare Notice of Proposed Rulemaking PDF

N4

Log-in to Rules and Regulations Database Submission Tool

AN

Select "Add a new Regulation" and complete the Filing Form

N

Upload PDF

N4

Complete submission and check/verify notice on Department of State website

NS

Publish notice of proposed rulemaking on agency's website

F. Submitting a Proposed Rule in the Database Submission Tool

1. Log-in to the Rules and Regulations Database Submission Tool
http://sos.ri.gov/dar_filing/.

2. Under Rule Information, click “Add new regulation” link.

3. Select your parent agency or division from dropdown; click on the GO
button.

4. Fill out the Filing Form with the following information:
a. Name and Address of Agency.
b. Title of Rule: If replacing a rule currently in effect, make sure that

the “Title of Rule” matches the title of the rule it replaces. If the title
will change, explain the title change as part of the Concise
Explanatory Statement. Do not use special characters (ex. *&"%$%)
in the title. Add the RICR citation in parentheses after the title of the
rule.

C. Statutory Source of Authority: Provide the complete citation (ex. R.I.
Gen. Laws § 42-35-2.7) for the statute enabling the agency to file a
rule on this subject matter.

d. Concise Explanatory Statement (8 42-35-2.6):
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(1) State your reasons for creating the rule; and
(2) Provide prepared regulatory analysis.

e. Type of Filing

a. Indicate the ERLID number assigned by the Rules and
Regulations Database Tool to the superseded and/or
expired rule.

b. If an Amendment, indicate the amended section numbers in

the text box provided.
e. Notice and Hearing Information

(1) Date of Public Notice (8 42-35-2.8): Indicate Public Notice
and Public Hearing Dates or check “Not Required”. For the
Public Notice date, use the date that you checked the
“Proposed” check box. Emergency rules do not require
Public Notice.

(2)  Date of Public Hearing (8 42-35-2.8): The hearing must be
held at least ten (10) days from the date of public notice.

A public hearing must be held if requested by at least
twenty-five (25) persons, or by an organization that has at
least twenty-five (25) members and must be at least five (5)
days before the End of the Comment Period.

If no Public Hearing planned, check the box for “Not
Required”.

3) Date of the End of Comment Period (8 42-35-2.8): The
end of comment period must be at least 30 days from the
date of public notice and at least five (5) days from the date
of public hearing.

f. Agency Additional Information - Web Page: In addition to
uploading your Notice of Proposed Rulemaking to the Department
of State’s website, you must post the Notice on your agency’s
website (8 42-35-2.7). Provide the website address here directing
the user to the Notice on your agency’s website.

5. Proofread everything.

6. Check the “Proposed” box when ready to begin the public comment
period.
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10.

11.

12.

13.

14.

15.

Click SUBMIT.

Click BROWSE and select PDF.

Click FINISH SUBMISSION.

In SELECT AN ACTION dropdown box, select “Front Page”.

You should now see your proposed rule under the “Regulation
Information” section in red. (If not red, click the pencil/paper icon to the
right of the title to edit the online filing form and ensure that you have
checked the “Proposed” box in section 5.).

If you have more proposed rules to submit, follow the same procedure.

When finished, select “Log Out” from the “Select an Action” dropdown box
on the Front Page.

View your proposed rule in our “Proposed” public search interface (select
your agency from the dropdown): http://sos.ri.gov/ProposedRules/. Make
sure all the information displays correctly and your PDF will open without
issue, and that the “Additional Information” directs to the appropriate
webpage on your agency’s website.

As proof that you have complied with the public notice requirement, print a
copy of the above screen with a date stamp contained in the header or
footer and keep in your rule-making file.

DO NOT MAKE ANY SUBSTANTIVE CHANGES DURING THE 30-DAY PUBLIC

COMMENT PERIOD.
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1.2.2 Finalizing Rules and Regulations and Filing (8 42-35-4)

After you have completed the Public Comment period and received approval from the
Office of Management and Budget to file the final regulations with the Department of
State, you will need to complete the following steps to finalize your rule for filing.

Receive approval from OMB to file final rule

N

Prepare the PDF of final rule

N

Update the Filing Form

N

Upload the finalized rule PDF

N

Prepare two original copies of Filing Form and final rule

N

File with Dept. of State

NS

Rule goes into effect twenty (20) days after filing

1. Prepare the PDF of the final rule which must contain the final text of the
rule without markup.

2. Updating the Filing Form & Uploading Finalized PDF:
a. Log-in to the Rules and Regulations Database Submission Tool:

http://sos.ri.gov/dar filing/login/

b. Click on the pencil and paper icon LI to the right of the title to edit
the Filing Form.

C. Complete the following:

(2) Concise Explanatory Statement (8 42-35-2.6) - This section
should now contain both the purpose of the filing and a
description of any substantive difference(s) between the
proposed rule and the final rule stating the reason(s) for the
difference(s). In addition, you must state the reasons for not
accepting arguments made in testimony and comments.
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If there are no substantive differences, please note this.

Keep in mind that no changes are allowed between the text
of the rule as proposed and the finalized rule except as a
logical outgrowth of the proposed rule.

You also must include the regulatory analysis prepared in
accordance with 8§ 42-35-2.9.

Finally, provide the date the final rule was signed by the
agency head and any finding required by law as a
prerequisite to the effectiveness of the rule.

See Appendix 7: Concise Explanatory Statement Template.

(2) Un-check the “Proposed” box.
3) Proofread everything.
(4)  Click SUBMIT.

(5)  This will return you to the “Regulation Information” screen,
but your rule title should now display in black. If still in red,
click the pencil/paper icon again, ensure you have un-
checked the “Proposed” box in Section 5 of the Filing Form
and submit the Filing Form again before proceeding.

d. Click on the red “U” to the right of the title to upload your PDF
containing the finalized rule.

e. Browse and select the PDF; click FINISH SUBMISSION.

f. Click the printer icon = to the right of the title and click the
“‘Download ...filing form...” link.

g. The Filing form should open in PDF format; check all information for
correctness, then print two originals of the Filing Form.

h. Have the Filing Forms signed and notarized and attach them to two
original copies of the finalized rule.

I. Make an appointment with the Administrative Records Office to file
by calling (401) 330-4801 or emailing rulesregs@sos.ri.qgov. Please
have the ERLID number(s) of all planned filings available prior to
requesting an appointment. (ERLID number(s) located on the upper
and lower right hand corner of the Filing Form.)
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J- Once filed with the Administrative Records Office, the final rule
displays in our FINAL RULES public search interface:
http://sos.ri.gov/rules/. The final rule will go into effect twenty (20)
days from the date of filing or a later date, if requested.

1.2.3 Direct Final Rules (8 42-35-2.11)

If an agency expects a rule to be non-controversial, the agency now has the option of
filing the rule as a Direct Final Rule.

Agency completes regulatory preparation and submits to OMB for review

NS

Prepare Notice of Proposed Rulemaking PDF including statement that you do not anticipate
the rule to be controversial

N4

Log-in to Rules and Regulations Database Submission Tool

N

Select "Add a New Regulation" and complete the Filing Form and upload the PDF which
clearly marks the proposed language by underlining proposed insertions, and striking through
proposed deletions

NS

Complete submission and check notice on the Department of State website

N

Publish Notice of Proposed Rulemaking on the agency website

N4

File the Filing Form and final version (without marks for proposed language) of Direct Final
Rule with the Department of State at any time during the 30 day public comment window

NS

If objection received by agency, file a copy of the objection with the Dept. of State. The rule
will not go into effect.

N

If no objection received after thirty (30) days, the agency uploads the final version of the rule
(without marks for proposed language) in the Rules and Regulations Database Submission
Tool and emails the Dept. of State to "verify" the rule on file is in effect. The rule goes into
effect 30 days from the date of Notice of Proposed Rulemaking.

A. Procedure for a Direct Final Rule. The agency will post Notice of Proposed
Rulemaking and in that notice the agency must include a statement that it does
not expect the rule to be controversial and that the proposed rule takes effect
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thirty (30) days after publication if no objection has been received (see Appendix
4: Direct Final Rulemaking Process).

1. A Direct Final Rule can be filed with the Department of State in its final
format (without marks for proposed language) at any time during the thirty
(30) day public comment period.

2. If no objection is received, the agency will email the Department of State
at rulesregs@sos.ri.gov stating that no objection has been received and
upload the final rule to the Rules and Regulations Database Submission
Tool.

3. If objection is received, the agency should email the Department of
State at rulesregs@sos.ri.gov with notice of the objection for placement on
file. The rule will not then go into effect after thirty (30) days.

4. If no objection was received, the Department of State will verify the Direct
Final Rule as in effect, making it accessible on the Department of State
website.
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1.2.4 Emergency Rules (8§ 42-35-2.10)

If an agency determines that an emergency rule (8 42-35-2.10) is required due to a
finding of imminent peril, they may file an emergency rule without Notice of Proposed
Rulemaking, Public Comment or a Public Hearing.

Agency finds that an imminent peril exists which requires the immediate filing of an emergency
rule

NS

Log-in to Rules and Regulations Database Submission Tool

Ny

Select "Add a new Regulation” and complete the Filing Form and upload PDF

N

Agency submits emergency regulation to OMB system for review

N

The agency head and the governor / governor's designee sign rule.
Rule immediately becomes effective for 120 days.

N

Agency publishes the rule and the agency's finding of imminent peril on the agency's website.

N

The agency files the rule with the Department of State.

NS

After 120 days is there still a need for the rule?

N

Yes
Rule may be renewed once for 60 days.

File Renewal with the Dept. of State prior to the expiration of the initial 120 day emergency
period.

No
Rule expires and previous rule comes back into effect, if applicable.

OR
Rule expired by the adoption of a rule that has completed the APA promulgation process.

1. The rule will go into effect when it has been signed by the agency head
and the Governor or Governor’s designee.

2. The rule will remain in effect for 120 days.
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3. An agency should follow the 1.2.2 Finalizing Rules and Regulations and
Filing with the exception that the rule should contain mark-ups to denote
deletions and additions to the existing rule, and must clearly state their
finding of imminent peril which requires the emergency rule.

4. The agency may renew the emergency rule once for an additional sixty
(60) days. The extension will need to be filed using the same procedure as
the initial emergency rule.

1.2.5 Technical Revisions for Making Minor Non-Substantive Corrections (8

A.

42-35-4(b))

A minor non-substantive change can be made through a written request from an
agency’s Rules Coordinator or initiated by Administrative Records Office staff. If
initiated by Administrative Records Office staff, the agency Rules Coordinator
must first approve the change. The scope of these notices can run from
grammar, punctuation, and cross-reference corrections, to a name change of the
agency.

The Agency Rules Coordinator emails a copy of the current rule to
rulesreqs@sos.ri.gov at Administrative Records Office in a Word or similar word
processing format for correction and includes a Concise Statement of the need
for the Technical Revision for completion of the Technical Revision.

The agency Rules Coordinator also adds an Authorized User to the agency’s
database account for use by the Administrative Records staff to use when
promulgating Technical Revisions for the agency.

Administrative Records Office staff creates the new Technical Revision filing in
the Rules and Regulations Database Submission Tool and notes on the Filing
Form the minor non-substantive corrections made and files the Technical
Revision with a copy of the email with the requested change by the agency or the
agency approval of such change in the folder with the corrected rule.

Administrative Records Office staff sign and notarize the Technical Revision.

The Technical Revision effective date is set to the same effective date as the rule
that it is correcting.
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1.3 Requirements under the APA

1.3.1 Rulemaking Agenda (8 42-35-5.1)

A.

The rulemaking agenda is a document listing all proposed rulemaking currently in
effect for your agency. The rulemaking agenda must be updated in real time and
include the following information for all rules proposed by your agency:

1. The subject matter of the proposed rule;

2. Notices related to the proposed rule;

3. How comments on the proposed rule may be submitted;

4, The time within which comments may be submitted;

5. Where comments may be inspected,;

6. Requests for a public hearing;

7. Appropriate information concerning a public hearing, if any; and
8. The timetable for action on the proposed rule.

If you use the provided Public Notice of Proposed Rulemaking template (see
Appendix 6: Public Notice of Proposed Rulemaking Template), your public notice
will contain all information required under 8§ 42-35-2.7 Notice of proposed
rulemaking. and 8§ 42-35-5.1 Rulemaking agenda.

The law requires that the rulemaking agenda be published both on the agency’s
website and the Department of State’s website.

The rulemaking agendas will be published on the Department of State website
using the current RSS feeds for the Proposed Rules and Regulations Database.
Your agency may utilize these feeds to display the current rulemaking agenda on
your own website. If you choose to use this feature you should work with your
agency’s IT department to paste the feed into your agency’s website for a live,
up-to-date list of your proposed rules. If you choose to not use the RSS feed
option, you will need to publish a current rulemaking agenda to your agency’s
website each time your agency proposes a rule or a proposed rule is no longer in
public comment.

1.3.2 Guidance Document Index (8 42-35-2.12)

1. Agency Rules Coordinators must submit a Guidance Document Index to
rulesregs@sos.ri.gov annually. The Administrative Records office will
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publish the annual index on the Dept. of State website on January 15% of
each year. (see Appendix 8: Example Guidance Document Index).

1.3.3 Declaratory Order and Index (8 42-35-8)

1.

If an agency issues a declaratory order, the order must contain the names
of all parties to the proceeding, its factual basis, and the reasons for the
agency's conclusion.

The agency must make an appointment with the Administrative Records
Office to file a copy of the Order by calling (401) 330-4801 or emailing
rulesreqs@so0s.ri.gov.

The Declaratory Order becomes effective once filed with the Department
of State.

Agency Rules Coordinators must compile a current index of all its effective
declaratory orders (see Appendix 9: Example Declaratory Order Index).
Whenever the index is updated it must be submitted to
rulesregs@sos.ri.gov.

1.3.4 Advance Notice of Proposed Rulemaking (8 42-35-2.5)

1.

If an agency chooses to gather information and solicit comments and
recommendations from the public the agency would need to send an email
to the Department of State (rulesregs@sos.ri.gov) with a copy of their
notice which indicates where, when, and how persons may comment
before the rulemaking process begins.

The Department of State will have a copy of the Advance Notice of
Proposed Rulemaking provided by the agency published in the Rhode
Island Government Register.

The agency publishes a copy of the Advance Notice of Proposed
Rulemaking on the agency’s website.

The meeting must be open to the public and is subject to the open
meetings chapter pursuant to R.l. Gen. Laws 8§ 42-46.

1.3.5 Petition for Promulgation of Rules (8 42-35-6)

1.

2.

Each agency must promulgate a rule prescribing the procedure for an
individual to petition the agency to promulgate a rule.

The rule must contain the following information:

a. the form of the petition;
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b. the procedure for submitting the petition to the agency; and

C. the procedure the agency must follow in considering and acting on
the petition.

Pursuant to 8 42-35-6, the agency must deny the petition or initiate
rulemaking in accordance with the petition within thirty (30) days.

The Department of State has provided a sample Petition for Promulgation
of Rules (Appendix 10: Sample Petition for Promulgation of Rules). This
sample is intended as a tool for agencies’ use in promulgating its rule as
required by the APA. Agencies are not required to use the sample when
promulgating their Petition for Promulgation of Rules.

1.3.6 Petition for Declaratory Order (8§ 42-35-8)

1.

Each agency must promulgate a rule prescribing the procedure for an
individual to petition the agency for a declaratory order.

The rule must contain the following information:

a. the form of the petition;
b. the procedure for submitting the petition to the agency; and
C. the procedure the agency must following in considering and acting

on of the petition.

Pursuant to § 42-35-8, the agency must act within sixty (60) days of
receipt of the petition in one of the following ways:

a. issue a declaratory order;
b. decline to issue the order; or
C. schedule the matter for further consideration

The Department of State has provided a sample Petition for Declaratory
Order (Appendix 11: Sample Petition for Declaratory Order). This sample
is intended as a tool for agencies’ use in promulgating its rule as required
by the APA. Agencies are not required to use the sample when
promulgating their Petition for Promulgation of Rules.

1.3.7 Conduct of Public Hearings (8 42-35-2)

1.

Each agency must promulgate a rule prescribing the manner in which
public hearings are conducted.
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2. The Department of State has provided a sample Conduct of Public
Hearings regulation (Appendix 12: Conduct of Public Hearings
Regqulation). This sample is intended as a tool for agencies’ use in
promulgating its rule as required by the APA. Agencies are not required to

use the sample when promulgating their Conduct of Public Hearings
regulation.
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Appendix 1. Examples of Styles in
the RICR Template

REPLACE THIS TEXT WITH THE FULL RICR NUMBER (XX-RICR-XX-XX-XX)

REPLACE THIS TEXT WITH THE RICR TITLE NUMBER — NAME
(AGENCY NAME)

REPLACE THIS TEXT WITH THE RICR CHAPTER NUMBER — NAME (FUNCTION)
REPLACE THIS TEXT WITH THE RICR SUBCHAPTER NUMBER - NAME (TOPIC)
REPLACE THIS TEXT WITH THE RICR PART NUMBER — NAME (REGULATION)

[The suggested numbering and format below will help you create your new regulation.
Replace each X’ with the appropriate number for both rule numbers and statute
citations - Delete this paragraph and any other extraneous text below.]

x.1 Replace This Text with a Heading (Title 1)

x.1.1 Replace This Text with a Subheading (Title 2 — this heading level is
optional)

A. Replace this text with Paragraph 1 — use the following subsections as
appropriate

1. Replace this text with Paragraph 2 (subsection of Paragraph 1)
a. Replace this text with Paragraph 3 (subsection of Paragraph 2)

(2) Replace this text with Paragraph 4 (subsection of Paragraph
3)
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Appendix 2. Example of Regulation in
the RICR Style

(This example is used for illustrative purposes only and should not be copied exactly)

281-RICR-10-00-2

TITLE 281 - RHODE ISLAND TURNPIKE AND BRIDGE AUTHORITY

CHAPTER 10 - BRIDGES AND TOLLS

SUBCHAPTER 00 - N/A

PART 2 - RULES AND REGULATIONS GOVERNING DISPUTES INVOLVING THE
NONPAYMENT OF TOLLS, ADMINISTRATIVE FEES, AND FINES

2.1

2.1.1

2.1.2

AUTHORIZATION AND PURPOSE
AUTHORIZATION FOR REGULATIONS

The following rules and regulations concerning the resolution of disputes over the
nonpayment of tolls, administrative fees, and fines ("Rules and Regulations") are
promulgated by the Rhode Island Turnpike and Bridge Authority ("Authority™) in
accordance with R.I. Gen. Laws § 24-12-37.

PURPOSE

These Rules and Regulations are intended to provide the public with information
regarding the procedures associated with the nonpayment of tolls, administrative
fees, and fines on the Claiborne Pell Bridge.

DEFINITIONS

For the purposes of these Rules and Regulations, the following terms shall have
the following meaning:

1. “‘Administrative Fees” means the fees added to an unpaid Toll pursuant to
R.l. Gen. Laws § 24-12-37.

2. “Bridge” means the Claiborne Pell Bridge.

3. “Fines” means all fines incurred by a Toll Evader under R.l. Gen. Laws §
24-12-37.

4. “‘Nonpayment of Toll” means the failure to pay any Administrative Fees or

Fines associated with the failure to pay the required Toll, and/or the failure
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to pay the Toll due at the time of crossing or use of the Bridge as a result
of:

a. having an insufficient amount of cash or legal tender to pay the Toll
due;
b. failing to have a properly-affixed and valid EZ-Pass Transponder

with a balance sufficient to pay the Toll due; or

C. not paying the Toll due or otherwise evading the obligation to pay
the Toll due by, inter alia, proceeding through or around a gate or
barrier at the Bridge’s toll plaza.

“Toll” means the amount charged by the Authority for use of the Bridge
pursuant to R.l. Gen. Laws § 24-12-9.

“Toll Violator” means any person who uses the Bridge and fails to pay or
prepay the required Toll.

“Toll Evader” means any person who uses the Bridge, fails or refuses to
pay the required Toll, and deliberately circumvents or proceeds around or
through a gate or other barrier on the Bridge; and/or any Toll Violator who
fails or refuses to prepay the required toll on a tolled project at least one
hundred (100) or more times, received at least three (3) written notices
from the Authority (or its agent) regarding the non-payment of Tolls, and is
not a party to, or in current compliance with, a written repayment plan with
the Authority.

“Notice of Violation” means any notice issued by the Authority (or its
agent) in connection with the Nonpayment of Toll by a Toll Violator or Toll
Evader.

RESOLUTION OF DISPUTES

Procedures for Disputing Notices of Violation

1.

The Authority intends to seek to resolve all disputes regarding the
Nonpayment of Tolls in an efficient and fair manner.

If a Toll Violator or Toll Evader disputes their status as such or otherwise
disputes the accuracy of the Authority’s records regarding any
Nonpayment of Toll, the Toll Violator or Toll Evader shall submit a
completed Toll Violation Dispute Form to the Authority within thirty (30)
days of the date of issuance of the disputed Notice of Violation.

The Authority will attempt to work informally and collaboratively with the
Toll Violator or Toll Evader to resolve any dispute regarding the disputed
Notice of Violation or Nonpayment of Toll. The Authority may contact the
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Toll Violator or Toll Evader to request additional information to assist the
Authority in evaluating the merits of the dispute.

4. If the Authority determines that the disputed Notice of Violation shall be
voided or adjusted in favor of the Toll Violator or Toll Evader, then the
Authority will make such adjustment and will advise the Toll Violator or Toll
Evader of the adjustment made. Thereafter, the Toll Violator or Toll
Evader shall pay the newly adjusted amount within ten (10) days of the
date of issuance of the Authority’s determination. However, if the Toll
Violator or Toll Evader fails to timely pay the adjusted amount, then any
adjustment made by the Authority is null and void and the original amount
of the Notice(s) of Violation (and any applicable Administrative Fees and
Fines) shall be immediately due and payable.

5. If the Authority determines that the disputed Notice of Violation is valid and
should not be voided or adjusted, then the Toll Violator or Toll Evader may
request a telephonic conference with a duly authorized Authority
representative for the purpose of attempting to resolve the dispute. Such
telephonic conference shall be conducted within thirty (30) days of the Toll
Violator or Toll Evader’s request, which request shall be made no later
than thirty (30) days of the date of issuance of the Authority’s
determination. If such conference is not requested or does not resolve the
dispute, then the Authority shall issue a written final determination to the
Toll Violator or Toll Evader confirming that all amounts owed for the
disputed Notice of Violation shall remain due and payable. Thereafter, any
such Toll Violator or Toll Evader shall remain subject to all consequences
set forth in R.l. Gen. Laws § 24-12-37.
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Appendix 3: Regular Rulemaking
Process
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Appendix 4: Direct Final Rulemaking Process
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Appendix 5: Emergency Rulemaking Process

Agency finds B bmits
imminent peril to OMB
which requires -
immediate filing o -

emergency rule

/

Emergency rule may be
renewed once, for 60
days. (Must be filed
within the 120
emergency period.)

Nellie M Gorbea — Secretary of State

OR

Agency head
and Governor
(or designee)

S|gn rule

Rule in effect
for 120 days

Rule expires and
previous rule
comes back into
effect, if applicable

Agency _

publishes rule :‘%Z’:;gl(l;s

?n:gqfrm'f g rule with

peril on their Dept. of State
\website

New rule that has
completed the APA
promulgation process
Is adopted addressing
the imminent peril

OR

Page |48



Appendix 6: Public Notice of
Proposed Rulemaking Template

RHODE ISLAND GOVERNMENT REGISTER
PUBLIC NOTICE OF PROPOSED RULEMAKING

AGENCY:
DIVISION: (If any)

RULE IDENTIFIER: (RICR Citation and ERLID of noticed rule and any ERLIDs effected by

proposed rule)
REGULATION TITLE:

RULEMAKING ACTION: (Advance Notice of Proposed Rulemaking, Proposed Rulemaking, or
Direct Final)

Direct Final: If no formal objection is received on or before [end of comment period]
[Agency, Board or Commission Name] will file the [adoption OR amendment OR repeal]
without opportunity for public comment. (If using Direct Final rulemaking, do not include the
PUBLIC HEARING INFORMATION and ALTERNATIVE PUBLIC HEARING TEXT sections
below.)

TYPE OF FILING: (Adoption, Amendment, or Repeal)

TIMETABLE FOR ACTION ON THE PROPOSED RULE: (Public notice date, end of comment

period date and hearing date, if any)

SUMMARY OF PROPOSED RULE: (In Plain Language provide a statement of the subject
matter of the proposed rule. Including the terms or substance of the intended action, OR a
description of the issues involved. Include a summary of any non-technical changes between

current and proposed regulations.)
COMMENTS INVITED:

All interested parties are invited to submit written or oral comments concerning the proposed
regulations by [end of comment period, must be at least 30 days from publication of

notice] to the addresses listed below.



ADDRESSES FOR PUBLIC COMMENT SUBMISSIONS:
Mailing Address:
Email Address:
WHERE COMMENTS MAY BE INSPECTED:
Mailing Address:
PUBLIC HEARING INFORMATION:
Hearing Location Date and Time:
Hearing Location Address:

The place of the public hearing is accessible to individuals who are handicapped. If
communication assistance (readers/interpreters/captioners) is needed, or any other
accommodation to ensure equal participation, please call [insert telephone number] or RI
Relay 711 at least three (3) business days prior to the meeting so arrangements can be made to
provide such assistance at no cost to the person requesting.

ALTERNATIVE PUBLIC HEARING TEXT:

In accordance with R.l. Gen. Laws § 42-35-2.8, an oral hearing will be granted if requested by
twenty-five (25) persons, by an agency or by an association having at least twenty-five (25)

members. A request for an oral hearing must be made within thirty (30) days of this notice.
FOR FUTHER INFORMATION CONTACT:

[ATTN: Name, Title, Division, Agency, Street Address, City, State, Zip. Include Phone Number
and Email Address.]

SUPPLEMENTARY INFORMATION:
Regulatory Analysis Summary and Supporting Documentation:

[Provide a brief paragraph of the societal cost and benefits and cost of compliance as prepared
under R.l. Gen. Laws § 42-35-2.9. Include any citations to scientific or statistical study, report, or
analysis that served as a basis for the proposed rule.] For full regulatory analysis or supporting

documentation see agency contact person above.

Authority for This Rulemaking: (State Statute, Federal Statute, Federal Regulation, Executive
Order)

Regulatory Findings:
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In the development of the proposed [adoption OR amendment OR repeal] consideration was
given to: (1) alternative approaches; (2) overlap or duplication with other statutory and
regulatory provisions; and (3) significant economic impact on small business. No alternative

approach, duplication, or overlap was identified based upon available information.
The Proposed Amendment:
[Agency Name] proposes to amend [RICR citation] as follows:

(Attach Full Proposed Regulation with Mark-Ups in RICR format)
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Appendix 7. Concise Explanatory
Statement Template

CONCISE EXPLANATORY STATEMENT

In accordance with the Administrative Procedures Act, R.l. Gen. Laws § 42-35-2.6, following is a

concise explanatory statement:
AGENCY:
DIVISION: (If any)

RULE IDENTIFIER: (RICR Citation and ERLID of noticed rule and any ERLIDs effected by

proposed rule)
RULE TITLE: Provide the full title of the rule.

REASON FOR RULEMAKING: Provide a brief description of the reason for the adoption,

amendment or repeal of the rule.

ANY FINDING REQUIRED BY LAW AS A PREREQUISITE TO THE EFFECTIVENESS OF
THE RULE: (if any)

TESTIMONY AND COMMENTS: Provide the reasons for not accepting arguments made in

testimony and comments.

CHANGE TO TEXT OF THE RULE: Identify any changes between the text of the rule as
proposed and the text of the final rule and explain why these changes were made to the final
text. Note that an agency may not file a rule that differs from the rule proposed in the notice of
proposed rulemaking unless the final rule is consistent with, and a logical outgrowth of, the rule

proposed in the notice.

REGULATORY ANALYSIS: Provide the text of the regulatory analysis prepared under R.1.
Gen. Laws § 42-35-2.9.

DATE THE FINAL RULE WAS SIGNED BY THE AGENCY HEAD: Provide the date that the

final rule was approved and signed by the head of your agency.
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Appendix 8: Example Guidance
Document Index

Annual Guidance Document Index —[Year]
[Agency Name and Address]

Effective Date Title Where to obtain a copy of

Guidance Document
(link or instructions how to

request document)
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Appendix 9: Example Declaratory
Order Index

Annual Declaratory Order Index —[Year]

[Agency Name and Address]

Effective Date Title Where to obtain a copy of the

Declaratory Order
(link or instructions how to

request document)
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Appendix 10: Sample Petition for
Promulgation of Rules

This sample is an example only and not intended to be prescriptive of an agency’s
requirements under the Administrative Procedures Act. Agencies may choose to
disregard this sample.

XXX-RICR-XX-XX-XX

RICR TITLE NUMBER — NAME (AGENCY NAME)
RICR CHAPTER NUMBER — NAME (FUNCTION)

RICR SUBCHAPTER NUMBER - NAME (TOPIC)

THE RICR PART NUMBER - PETITION FOR PROMULGATION OF RULES
x.1 Purpose
The purpose of this regulation is to prescribe the form of a Petition for

Promulgation of Rules pursuant to R.I. Gen. Laws 8§ 42-35-6 and the procedure
for its submission, consideration, and disposition.

X.2 Authority

This regulation is promulgated pursuant to the authority granted in R.l. Gen.
Laws § 42-35-6.

x.3 Definitions

A. The following definitions shall apply to this regulation:
1. "Department” means <insert agency>.
2. "Petition" means a request for the Promulgation of a Rule.
3. "Petitioner" means a person requesting the promulgation of a rule.
4, "Promulgate”, with respect to a Rule, means the process of writing a new

Rule, or amending or repealing an existing Rule.

5. "Rule" means the whole or a part of an agency statement of general
applicability that implements, interprets, or prescribes law or policy or the
organization, procedure, or practice requirements of an agency and has
the force of law. The term includes the amendment or repeal of an existing
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rule. The term is used interchangeably with the term "regulation.” The term
does not include the exceptions listed in R.l. Gen. Laws § 42-35-1(19)(i)-

(vi).

x.4 Request for the Promulgation of a Rule

A. A request to Promulgate a Rule must be in writing and include the following
information:
1. The name and address of the Petitioner;
2. A plain statement identifying the rule or proposed new Rule at issue;
3. A detailed statement of all facts relied upon by the Petitioner;
4. A plain statement requesting the Promulgation of a Rule, and further

indicating whether Petitioner seeks a new Rule or the amendment or
repeal of an existing Rule.

a. In the case of a request for the repeal of an existing Rule, the
Petitioner shall identify the Rule by title and/or RICR citation.

b. In the case of a request for an amendment to an existing Rule, the
Petitioner must identify with specificity any proposed additions,
deletions, or other amendments. New proposed language must be
clearly marked using underline formatting for proposed insertions,
and strikethrough formatting for proposed deletions.

B. A request for the Promulgation of a Rule must be submitted to:

<Insert agency contact information.>

x.5 Consideration and Disposition of Request for the Promulgation
of a Rule

A. The Department shall promptly consider and respond to the request for the
Promulgation of a Rule as provided in R.l. Gen. Laws § 42-35-6.

B. The Department may, at its discretion and within the thirty (30) day period
prescribed by statute:

1. Hold a hearing for further consideration and discussion on the Petition; or

2. Request further information or documents from the Petitioner necessary
for the full evaluation of his or her Petition.
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Appendix 11: Sample Petition for
Declaratory Order

This sample is an example only and not intended to be prescriptive of an agency’s

requirements under the Administrative Procedures Act. Agencies may choose to

disregard this sample.

XXX-RICR-XX-XX-XX

RICR TITLE NUMBER - NAME (AGENCY NAME)

RICR CHAPTER NUMBER — NAME (FUNCTION)

RICR SUBCHAPTER NUMBER - NAME (TOPIC)

RICR PART NUMBER — DECLARATORY ORDER PETITIONS

x.1 Purpose
This regulation states the requirements for submitting a request for Declaratory
Order under R.I. Gen. Laws 8§ 42-35-8(b), and the procedure for its consideration
and prompt disposition.

X.2 Authority

This regulation is promulgated pursuant to the authority granted in R.I. Gen.
Laws § 42-35-8.

x.3 Definitions

A. The following definitions shall apply to this regulation:
1. "Declaratory Order" means an order issued by the Department that:
a. Interprets or applies a statute administered by the Department;
b. Clarifies whether a rule, guidance document, or order issued by the
Department applies to a Petitioner; or
C. Clarifies how a rule, guidance document, or order issued by the
Department applies to a Petitioner.
2. "Department” means <insert agency>.
3. "Petition" means a request for a Declaratory Order.
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X.4

X.5

4, "Petitioner" means a person requesting a Declaratory Order.
Request for Declaratory Order: Form and Submission

A request for Declaratory Order must be in writing and include the following
information:

1. The name and address of the Petitioner;

2. A plain statement identifying the statute, rule, guidance document, or
order at issue;

3. A detailed statement of all facts relied upon by the Petitioner;

4, A copy of any and all documents relied upon by Petitioner that are not
otherwise accessible to the Department; and

5. A plain statement requesting a Declaratory Order, and further indicating
whether Petitioner seeks:

a. An interpretation or application of a statute administered by the
Department;
b. Clarification as to whether a rule, guidance document, or order

issued by the Department applies to Petitioner; and/or

C. Clarification as to how a rule, guidance document, or order issued
by the Department applies to Petitioner.

A request for a Declaratory Order must be submitted to: <insert agency contact
information.>

Consideration and Disposition of Request for Declaratory Order

The Department shall promptly consider and respond to the request for
Declaratory Order as provided in R.l. Gen. Laws § 42-35-8(c).

1. Should the Department schedule the matter for further consideration, the
Department shall notify Petitioner in writing of the anticipated date on
which the Department will grant or deny the request for Declaratory Order.

The agency may, at its discretion:
1. Hold a hearing for further consideration and discussion on the Petition; or

2. Request further information or documents from the Petitioner necessary
for the full evaluation of his or her petition.
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C. A Petitioner may appeal the Department's final disposition of the request for
Declaratory Order as provided in R.l. Gen. Laws § 42-35-15.
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Appendix 12: Sample Conduct of
Public Hearings Regulation

This sample is an example only and not intended to be prescriptive of an agency’s
requirements under the Administrative Procedures Act. Agencies may choose to
disregard this sample.

XXX-RICR-XX-XX-XX

RICR TITLE NUMBER - NAME (AGENCY NAME)

RICR CHAPTER NUMBER - NAME (FUNCTION)

RICR SUBCHAPTER NUMBER - NAME (TOPIC)

THE RICR PART NUMBER — CONDUCT OF PUBLIC HEARINGS

x.1 Purpose

To establish a defined set of procedures for the <insert agency> for the conduct of
Public Hearings regarding Proposed Rulemaking.

Xx.2 Authority

This regulation is promulgated pursuant to the authority granted in R.I. Gen. Laws § 42-
35-2(a)(4).

x.3 Definitions

A. For the Purpose of this regulation:
1. "Department” means <insert agency>.
2. “‘Member of the Public” means any individual, firm, business, corporation,

association, partnership or other group.

3. “Presiding Department Official” means the <insert agency> employee
conducting the Public Hearing.

4. "Public Hearing" means the convening of Members of the Public and
agency personnel for the purpose of obtaining public comment on a
Proposed Rulemaking.
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5. “Proposed Rulemaking” means a proposed new rule, proposed
amendment to a rule or proposed repeal of a rule as noticed pursuant to
R.I. Gen. Laws § 42-35-2.7.

x.4 Procedure for Conduct of Public Hearings
A. Convening of Public Hearing

1. Public Hearings may be held at the election of the agency or as required
pursuant to R.l. Gen. Laws § 42-35-2.8(c).

2. Notice of Public Hearings shall be issued in accordance with the
provisions of R.I. Gen. Laws 88 42-35-2.8 and 42-46-6, when applicable.

3. The Public Hearing shall be held at a time and place designated by the

Department.
B. Transcription
1. The Public Hearing shall be transcribed by a stenographer or audio
recorded.
2. For Public Hearings, any official transcript, recording, or memorandum

summarizing presentations prepared by an agency official shall be made
part of the rulemaking record in accordance with R.I. Gen. Laws § 42-35-
2.3(b)(5).

C. Testimony

1. Oral Testimony
a. Members of the public may make oral testimony during the
meeting.
b. Members of the public who wish to make oral testimony during the

meeting must put their name on the speaker list.

C. Members of the public will be called to testify in the order which
their names appear on the speaker list.

2. Written Testimony

a. Written testimony must be submitted via e-mail, fax, hand delivery
or regular mail to: <insert contact information>.

D. Disruptive Conduct

1. Members of the Public attending the Public Hearing shall not cause
disruptions, including but not limited to: screaming, loud noises, and
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disorderly gesticulations, which interrupt or distract from the testimony of
other Members of the Public or from the ability of the Presiding
Department Official to conduct the Public Hearing.
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